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Public Health Epidemiology for 
Law Enforcement 

A Public Health Investigation Primer 
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Presenter
Presentation Notes
NOTES:

This set of slides is intended as a template for an experienced public health epidemiologist – from a local, State or Federal public health agency – to speak from in the Forensic Epidemiology course. As a template, they are designed to be customized to be correct for the jurisdiction(s) where the course is being held. You should go through and, as far as possible, answer the questions posed in the bullets, or customize them to local practices and organizations. Feel free to create more slides, if you need, to cover the issues in the templates. Also feel free to add additional topics as needed for local use. Experience has shown, however, that people without a public health background will benefit greatly by hearing about the topics outlined on this template.  

You may leave the slides as they are, to prompt you to say the right things about these issues, but we strongly recommend that you customize them. The participants in the course should have a copy of your slides in their notebooks, and you will want to be sure that they take the appropriate information home with them.  

This presentation should last approximately 50 minutes, including time for questions and answers. As a result, it may be necessary to remove some of the topics covered. This should be done at the discretion of the local planning committee and the presenter of this slide set.

Add your own name as the presenter and your own subtitle if you like. Text that is designed to be replaced or edited is colored in RED.  Other material should be edited or customized as needed.  

A space is provided in each slide for your organization’s seal or logo. In order to access the area in which the logo will reside, you must go to the slide master. To do this go to the View menu, then select Master, Slide Master. Replace the “Insert seal or logo here” generic logo on the slide master with the appropriate logo for your jurisdiction’s public health department. This will replace the logo on all but the title slide. To change the logo on the title slide, go to the View menu, then select Master, Title Master. Replace the “Insert seal or logo here” generic logo on the title master with the appropriate logo for your jurisdiction’s public health department. 

Make sure all the text is legible (e.g., white on blue background, not red on blue) when slides are complete. To change the color of the text, highlight the text that needs to be changed, go to the Format menu, then Font, then change the color to white. 

Currently, the date is located in the footer. To change the date from the generic “Date” to the date of the presentation, go to the View menu, then select Header and Footer.  Under footer, replace “Date” with the appropriate date, then select Apply to All. 

To change the presenter’s name and change the color of the text in the footer you must go to the slide master. To do this, go to the View menu, then select Master, Slide Master. Highlight the generic “Presenter’s name”, change it to the reflect the name of the presenter, then go to the Format menu, select Font and change the color to white. Highlight <footer>, go to the Format menu, select Font and change the color to white.
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Goals of This Lecture 

• Learn common public health terminology 
• Learn how public health agencies approach 

preventing and controlling infectious diseases 
• Learn how epidemiologists approach finding, 

investigating, and controlling outbreaks 

Presenter
Presentation Notes
NOTES:

The intended audience for this presentation is a mixed group of law enforcement, public health, and perhaps other public safety professionals who want to learn how to work together in investigating disease outbreaks that are or may also be crimes – bioterrorist events or other deliberately-caused outbreaks.
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Public Health 

• Organized federal, state and community effort to 
protect, promote and improve the health of its 
citizens 
– Primary care: focus on individuals 
– Public health: focus on populations 

• A social institution, a discipline and a practice  

Presenter
Presentation Notes
NOTES:

You may want to add, depending on local conditions, that providing direct clinical services (like prenatal care or AIDS patient care) is only part of a local health department’s mission.



Insert seal  
or logo here 

Date 4 Presenter’s Name 

Goals of Public Health 

• Goal: to reduce the amount of premature 
disease and disability in the population 

Presenter
Presentation Notes
NOTES:

You may want to add, depending on local conditions, that providing direct clinical services (like prenatal care or AIDS patient care) is only part of a local health department’s mission.
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Public Health and Law 
Enforcement Goals Compared 

Law enforcement: 
 

• Stop further crimes 
• Protect health and safety 

of public 
• Apprehend and convict 

criminals 

Public health: 
 

• Stop further cases of 
disease and outbreaks 

• Protect health and 
safety of public  

• Build science base for 
future prevention 

Presenter
Presentation Notes
NOTES:

This slide compares the goals of law enforcement and public health, showing the commonalities.
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Terminology 

• Case:  the totality of an investigation or a 
person? 

• Suspect: a person under suspicion or a 
person who may be a case? 

• Victim vs. Case 
• Evidence: criminal vs. scientific 

Presenter
Presentation Notes
NOTES:

Terminology: Public health and law enforcement differ in their definitions.

For public health workers, the word “case” refers to an individual person who has a case of a particular disease. Usually there are formal criteria for deciding medically which ill persons are “cases” of the disease under investigation. An outbreak is made up of one or more, usually many, cases. Most law enforcement workers would use the word “victim” to mean something close to this concept.  

For law enforcement workers, the word “case” usually refers to all the activities, interviews, evidence, etc related to one crime or set of related crimes. Most public health workers would use the word “investigation” to convey this concept.  

Public health workers may classify people who may be cases of a disease for investigative purposes into possible, probably, suspected, or confirmed cases.  So they may refer to a group of ‘suspects’, who are people who are strongly suspected of having the disease, that is, being cases. To law enforcement workers, of course, “suspect” refers to a person who is suspected of having committed or aided in committing the crime.  

Public health and law enforcement workers both collect evidence in the course of their investigations. Such evidence for public health workers may include inspection reports from facilities, interviews with ill and well people possibly exposed to the disease agent, medical records of ill people, historical records of previous cases and outbreaks of this disease, etc. Some but not all of this material can be tagged or secured in an evidence locker, or subject to chain of custody procedures.  



Insert seal  
or logo here 

Date 7 Presenter’s Name 

Epidemiology 

• Originally, the study of epidemics / outbreaks 
 

• Study of the factors that contribute to illness in 
individuals and communities, and how to 
improve health by altering those factors 

Presenter
Presentation Notes
NOTES:

The purpose of this slide is to define epidemiology. You may replace it with your preferred definition of epidemiology.

From Webster:
Epidemiology is a branch of medical science that deals with the incidence, distribution, and control of disease in a population�or the sum of the factors controlling the presence or absence of a disease or pathogen.
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Epidemiology 

• Examples of health problems: infectious 
diseases, chronic diseases, unintentional 
injuries, violent injuries, deaths 
 

• Why are some people sick and not others? 

Presenter
Presentation Notes
NOTES:

The last bullet on this slide is optional – some people like explaining the purpose of epidemiology this way: answering this question and explaining the answer is really the central activity of most epidemiologic work.
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Public Health Emergencies 

• Threat and reality of bioterrorism have focused 
attention on public health preparedness for 
emergencies 

• Planning for public health emergencies requires 
interagency agreements, training, and exercises 

Presenter
Presentation Notes
NOTES:

Explicitly mention the law enforcement and other public safety participants as welcome partners with public health agencies in dealing with emergencies that have health components. Some managers of this course may want to have a brief presentation by the local or state emergency management director as part of this course, with the goal of motivating people to get trained in the Incident Command System approach to dealing with emergencies and to organize and participate in multi-agency exercises. 
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Public Health Emergencies 

• Examples of public health emergencies:  
– Natural disaster: hurricanes, floods, 

earthquakes; 
– Outbreaks from contaminated food or water, 

influenza pandemics; 
– Biological, chemical, radiological and nuclear 

WMD  

Presenter
Presentation Notes
NOTES:

This slide is used to discuss and provide examples of public health emergencies.
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Local-State-Federal 
Relationships 

• Public health is constitutionally a state matter 
• Local health agencies: disease surveillance, 

initial outbreak investigations 
• State health agencies: technical assistance, 

policy guidance, lab support, field assistance, 
resources (vaccines, drugs, …) 

Presenter
Presentation Notes
NOTES:

You may want to modify the relative roles of local and state agencies for your jurisdiction, e.g., in a state where state provides most services directly.
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Local-State-Federal 
Relationships 

• CDC provides resources when outbreaks 
exceed state capacity, are multi-state or 
international, or result from bioterrorism 

• For events within states, CDC usually 
investigates only on request of state health 
department 

Presenter
Presentation Notes
NOTES:

In the case of a bioterrorist (BT) event, the state would still invite CDC to participate in the epidemiologic investigation, but the FBI would also bring CDC in as a Federal resource.
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Varieties of Local Health 
Departments 

What Do We Have Here? 
• City agencies 
• County agencies 
• City-county agencies 
• Multi-county agencies 
• County or multicounty branches of state health agency 
• Direct service by state health department 
• Does this jurisdiction have a local board of health? 

Presenter
Presentation Notes
NOTES:

Use this slide to describe the structure and reporting relationships of local health departments in the jurisdiction where the course is being given.

All items in red are meant to be customized by the local public health organization.
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Local Health Department  

• Responsibility and authority to investigate all 
epidemics, outbreaks, and issues of public 
health concern 

• First responder for investigating and controlling 
biological WMD events 

• County Health Dept Director is Public Health 
Officer 

• Epidemiologist – Disease Detective 

Presenter
Presentation Notes
NOTES:

Correct the title of your local public health agency and give the name of the director of the local public health agency. 
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Public Health ‘Police Powers’ 

• Inspect or close premises 
• License and discipline health professionals and facilities 
• Limit the movements of people (isolation, quarantine) 
• Require vaccination, testing, or treatment 
• Seize, embargo, impound food and other hazardous 

substances, or stop their sale 
• Board planes, trains, buses, and ships as part of disease 

control 
• Review medical, hospital etc. records 
• Interview whoever and whenever information is needed 

for investigation of a public health problem 

Presenter
Presentation Notes
NOTES:

Modify as needed to reflect the powers of the state(s) and localities where the course is given. In some states local health officers are issued badges to reflect their health-related police powers. 

You will probably need to use two or more slides to enumerate these powers fully. 
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Public Health Agencies Also 
Regulate 

• Most PH agencies have powers to take 
disciplinary actions against licensed entities 
(restaurants, day-care centers, health care 
workers, etc.) 

• These are handled as administrative law issues, 
not crimes 

• Criminal prosecutions are very rare  

Presenter
Presentation Notes
NOTES:

The regulatory powers are distinct from the police powers.  
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Who Works in Public Health? 

• Many disciplines: 
– Doctors (MD, DO, DVM, PhD) 
– Nurses (RN, PHN) 
– Laboratory workers (microbiologists, 

technologists) 
– Social workers, health educators 
– Environmental health workers 
– Attorneys 
– Administrators 

• Many have additional degrees/training in 
public health  

Presenter
Presentation Notes
NOTES:

Use this slide to indicate who works in the field of public health.
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What is an Outbreak? 

• An outbreak is the occurrence of more cases of a 
disease than expected in a population during a certain 
time 

• One case of smallpox, anthrax, plague,  botulism, or 
tuberculosis anywhere in the US is an outbreak requiring 
immediate response 

• An epidemic and an outbreak mean the same thing  
– Epidemic is often applied to an outbreak of special concern 

Presenter
Presentation Notes
NOTES:

Labeling a situation as an outbreak or epidemic implies that a public health response is required. Other examples of serious uncommon diseases where one case is an outbreak and requires an immediate public health response would include polio, measles, diphtheria, meningococcal meningitis, hemorrhagic fever, tuberculosis, or infectious syphilis. These are diseases where the risk of mortality or serious morbidity is high, and a single case has the potential to turn into an outbreak that has many cases and is hard to control.  

In practice public health spokespeople tend to use the word outbreak when they are trying to minimize public concern and epidemic when they are trying to increase it. 
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How Are Outbreaks Detected? 

• Recognized and reported by individual doctors or groups 
(e.g., an emergency dept) Add your reporting number 
here! 

• Recognized and reported by those affected (e.g., 
coworkers, school, banquet) 

• Detected by PH agency through review of individual 
cases reported by doctors, or review of lab reports or 
other health care data 

• Enhanced surveillance in cooperation with state and 
federal public health officials 

Presenter
Presentation Notes
NOTES:

If you have local examples of how outbreaks were detected by some or all of these methods, you should mention them.  E.g., “We detected the outbreak of shigella gastroenteritis associated with the downtown interactive fountain last year because parents of affected children called us.” or “We found the outbreak of hepatitis B associated with a dentist three years ago by reviewing our routine interviews with newly reported cases of hepatitis B.”  This also conveys the idea that your health department regularly recognizes and responds to outbreaks.

Add your agency’s reporting number to the slide.
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Surveillance 

• The ongoing, systematic collection, analysis, 
and interpretation of health data essential to 
the planning, implementation, and evaluation of 
public health practice, closely integrated with 
the timely feedback of these data to those who 
need to know. 
 

 In public health, ‘surveillance’ means tracking the 
occurrence of diseases of importance – not watching 
individuals or premises 

Presenter
Presentation Notes
NOTES:

To many people in the law enforcement profession, surveillance means watching an individual carefully, perhaps including having the person followed or having his telephone monitored. It also means watching a location, as with surveillance cameras.
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Communicable Disease 
Reporting 

• About 60 diseases reportable in most 
jurisdictions 

• Includes diseases linked with bioterrorism 
• What mechanism does this jurisdiction use to 

collect case reports from physicians, hospitals, 
and laboratories? 

• Does this jurisdiction have a way to detect 
outbreaks based on early symptoms or 
syndromes, before diagnoses are made? 

Presenter
Presentation Notes
NOTES:

Customize the first two bullets with the actual number of diseases reportable in this jurisdiction.

The third and fourth bullets are a place to indicate how this jurisdiction does public health reporting and surveillance. It is important to be concise and specific, e.g., “In this city, we receive reports from doctors over the telephone and by fax; we also depend heavily on infection control nurses, who are very complete about reporting every hospitalized case of a reportable disease, and hospital and clinical laboratories, who are very complete about reporting every laboratory result that indicates the presence of a case.  We are also currently piloting a system to count the daily number of emergency department visits at three hospitals for several conditions of interest, and expect to have it operational within three months.”

This information leads directly into the next slide, where you can point to the mechanisms as they work in this community.
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Communicable Disease Reporting  
-- Passive Surveillance 

LHD Hospital Clinic/ 
Office Lab 

LHD 

State 

CDC 

Public 
or 

Presenter
Presentation Notes
NOTES:

LHD = Local Health Department.

The dotted lines from the laboratory box to state and local health departments reflect the fact that this is variable among jurisdictions – in some states or areas all lab reports go to the state and are redistributed to the local health departments; in some all lab reports go directly to local health departments; and some have a mixed system. You could devote 10 seconds to saying which way it works in your community. 

The upper left hand box reflects the fact that local health departments may also be sites of clinical care on their own, and so may know about cases of reportable diseases (e.g., tuberculosis or STDs) internally, without having to receive reports from other providers.  
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How Do Infectious Diseases 
Spread? 

• Airborne  
• Common source (food or water) 
• Person-to-person 
• Vector-borne 

Presenter
Presentation Notes
NOTES:

This slide is used to briefly mention the way infectious diseases spread.
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Airborne 

Aerosolized infectious agents enter lungs 
 

• Anthrax 
• Plague (pneumonic form) 
• Smallpox 
• Tuberculosis 
• Influenza 
• Measles 
• Whooping cough 
• Legionnaires’ Disease 

Presenter
Presentation Notes
NOTES:

This slide discusses the way infectious diseases spread in the air. Several of these diseases are transmitted through the air from person to person. Mention that these diseases vary enormously in infectiousness. For example, tuberculosis is usually spread very slowly and inefficiently, so that you have to live with someone for months to be sure of getting infected; while measles is highly infectious, with most susceptibles getting infected after less than an hour in the presence of a case.  

The infectiousness by the airborne route of agents being used in a bioterrorism attack can be greatly affected by how the material is prepared – particle size, surfactants etc. This lesson was brought home by the Hart Senate Office Building and media attacks in fall of 2001. What we know of the agent in its natural state may not be correct in a BT setting. 

In some regions of the country you might want to add coccidiomycosis (valley fever) or histoplasmosis to the list.  
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Common Source 

• Food  
– Place: restaurant, home, store 
– Item: ground beef, eggs, salad 

• Water  
– Drinking water 
– Swimming pool, lake, hot tub, fountain 

Presenter
Presentation Notes
NOTES:

This slide discusses how infectious diseases spread via food and water.

A variety of conditions can be spread from a common source via the air, and you could give examples if they are locally familiar, such as coccidiomycosis in Arizona and southern California, or legionnaires’ disease from cooling towers with spread into neighborhoods. 
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Person-to-Person 

• Direct contact 
– HIV, Sexually transmitted diseases, smallpox 

• Indirect contact  
– Fecal-oral 
– Shared towels, combs or toys 

• Face-to-face via droplets 
– Coughing, sneezing 

Presenter
Presentation Notes
NOTES:

This slide discusses how infectious diseases can be spread from person-to-person.

The phrase ‘fecal-oral’ may need some explanation. You might say “People who are sick with diarrhea may transmit infection to others if they have not washed their hands thoroughly between using the toilet and fixing food for other people.”
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Vector-Borne 

• West Nile Virus (mosquitoes) 
• Malaria (mosquitoes) 
• Lyme disease (ticks) 
• Plague, typhus (fleas) 
• Saint Louis Encephalitis (mosquitoes) 

Presenter
Presentation Notes
NOTES:

This slide discusses vector-borne diseases.

Vector-borne diseases are thought unlikely to be good BT agents precisely because they depend on behavior of vectors, which is hard to control. The possibility that West Nile Virus might have been introduced into the United States deliberately to cause disease and disruption was seriously considered, but eventually rejected by investigators. Its rapid and wide spread in North America indicates how hard it is to predict where such an agent will go.  

You may want to customize this list based on common diseases in your area of the country, especially if they have gotten publicity e.g., hantavirus infection. 
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Incubation Period 

• Time interval between initial infection and onset 
of clinical features of disease 
– Very short: influenza, colds (12-36 h) 
– Short: salmonella (24-72 h) 
– Long: measles (10-14 d), hepatitis A (2-6 wks) 
– Very long: hepatitis B (6 w – 6 mo), TB (mos – yrs) 

• Key concept in disease transmission and control 
• For some diseases, people are infectious during 

part of the incubation period 

Presenter
Presentation Notes
NOTES:

This slide discusses the definition of incubation period and gives incubation periods for several diseases. 

TB = tuberculosis
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Steps in an Outbreak 
Investigation 

• Detect problem by public health surveillance 
• Verify diagnosis 
• Confirm epidemic 
• Identify / count cases 
• Characterize data → time / place / person 
• Take immediate control measures 
• Formulate / test hypotheses 
• Implement / evaluate additional control measures 
• Report findings  

Presenter
Presentation Notes
NOTES:

The slides following this one go through each of these bullets using an actual outbreak investigation as an example. You should feel free to substitute an example from a locally familiar outbreak investigation for this one, which comes from Great Falls, Montana, in 1977. It was chosen because it was simple and clear-cut, while illustrating each of the steps. No matter how interesting the local outbreak, you should not use more slides than one per step as done here, except for a small number of visuals as used here (spot map, line list, epidemic curve). 
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Detect Problem 

• Infection control nurse at one hospital in a city 
reports to the local health department that 4 
people were admitted overnight with bloody 
diarrhea and fever 

Presenter
Presentation Notes
NOTES:

On this slide, indicate how the problem in your area was detected (if substituting a local outbreak investigation for this one).
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Verify Diagnosis 

• Health department epidemiologist contacts 
hospital and clinical labs and confirms diagnosis: 
Shigella sonnei 

Presenter
Presentation Notes
NOTES:

On this slide give information on the diagnosis of the organism causing your outbreak.
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Confirm Epidemic 

• Epidemiologist checks with other hospitals and 
labs to see if there are any additional lab-
confirmed cases  finds 5 more, with additional 
specimens cooking 

Presenter
Presentation Notes
NOTES:

Likely with 9 people hospitalized, there are dozens of less severe cases in the community. (While it may eventually be useful to find most of the cases to give a bigger sample size for analysis and to document the size of the outbreak, working initially with just the hospitalized and lab-confirmed cases may lead to solving the outbreak quickly and economically.)
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Identify and Count Cases 

• County epidemiologist investigates: 
– Talks to cases  
– Learns of other ill people  
– Arranges for lab testing 
– Develops case definition (diarrhea plus fever >101 or 

positive culture) 
– Alerts primary care physicians/ emergency 

departments to look for and report additional 
shigellosis cases and recommends lab testing 

Presenter
Presentation Notes
NOTES:

Case definition here is stated very simply. In this situation it might really be that simple. The point here is to illustrate use of a case definition quickly and clearly. The case definition may be modified later in the outbreak investigation.  

Looking for additional cases is important if the mode of spread is not immediately obvious. The alert to physicians would contain recommendations for case and contact management. This is a good place to quickly describe how your state and local health departments have implemented the Health Alert Network. The local health department should now be able to notify clinicians of the nature and extent of the problem, and of what they need to do, very quickly and effectively.  
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Characterize Data by Time / 
Place / Person 

• Epidemiologist interviews cases looking for common 
exposures (e.g., day-care, restaurant, unusual food item) 

• Most cases report eating at one Mexican-theme fast-
food outlet in the southeast part of city about 2 days 
before onset of illness 

• Makes list of cases, plots cases on city map, draws time 
line 

• Epidemiologic tools can be used to show that an 
outbreak is NOT of natural origin 

Presenter
Presentation Notes
NOTES:

Note that the usual incubation period for shigellosis is one to three days, so this incubation period makes sense.
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Spot Map 
* = one case * = restaurant 

* 

* * 

* 

* * 

* 

* 
* 

Presenter
Presentation Notes
NOTES:

A spot map in its native form may effectively identify individuals, so maps used internally within the investigation may not be suitable for public display because of confidentiality concerns. 

A useful map may be made with stick-pins and a gas station map posted on the wall.  Geographical information systems are of course useful but using them should not slow down the investigation 
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Line List 

Line list of cases of probable and confirmed shigellosis
Great Falls, MT, May, 1979

Initials
Date of 
onset

Time of 
onset Diarrhea Fever Culture Category

RS 4 4:00 AM Y Y Pos Conf
GM 4 6:00 AM Y Y Pending Prob
AH 4 8:00 AM Y Y Pos Conf
JM 4 2:00 PM Y Y Pos Conf
TD 4 3:00 PM Y Y not done Prob
JD 4 4:00 PM Y Y Pos Conf
LR 5 6:00 AM Y Y Pos Conf
AR 5 11:00 AM Y Y Pending Prob
RG 5 7:00 PM Y N Pending Poss
TM 5 9:00 PM Y Y Pos Conf

Presenter
Presentation Notes
NOTES:

A real line list would probably include age, sex, home address, work location, and other relevant facts about each person.  Combined with initials, those data would identify individuals. Line lists from which individuals can be identified must be handled with the same attention to individual confidentiality as other medical and interview records. Generally state law prevents health agencies from releasing the names of individuals with medical conditions, including reportable diseases. Disease reporting depends on the active cooperation of physicians, hospitals, and laboratories, and would essentially vanish if names of persons reported tended to appear in the media. 

Line lists are working documents. Which category a person falls into will change as more information is acquired during an investigation.
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Epidemic Curve 
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Cases of shigellosis, Great Falls, May 1979 
 

Presenter
Presentation Notes
NOTES:

This graph indicates sudden appearance of cases and outbreak only lasting two days.  

The point to bring out here is that dates of onset can be graphed, and that the shape of the epidemic curve may tell whether the outbreak is due to a point source that only lasted a brief while or is due to a continuing source. This both helps solve the outbreak and helps decide whether there is a continuing problem that must be addressed immediately.

Computers can help with making these graphs. Preliminary graphs like this one can be made in Microsoft® Excel or can be drawn with pencil and graph paper.   
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Prevention and Control 
Measures 

• Visit to food outlet finds food handler who had a 
compatible illness on the right days. Her job was 
shredding lettuce. 

• Health department  
– Orders this person taken off the job 
– Reinforces hand washing for all food-handlers 
– Cultures all employees 

Presenter
Presentation Notes
NOTES:

Health department staff often have to take action based on the facts at hand, even when they are incomplete.
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Formulate / Test Hypotheses 

• All cases report eating items with lettuce from 
one restaurant 

• Only half of restaurant orders include items with 
lettuce 

• Only the lettuce-shredder has positive culture for 
Shigella sonnei 

   
  Conclusion: outbreak caused by 

 contamination of lettuce by ill foodhandler 

Presenter
Presentation Notes
NOTES:

The argument here is that if all cases had eaten items with lettuce, but only half of meals served in the store had lettuce in them, then lettuce is associated with illness.  

As the outbreak can be explained by known lapses in technique and an ill foodhandler, there is no need to think of this outbreak being intentional. However, the manager or other employees might tell the investigator that they suspect the worker who shredded the lettuce of having a grudge against the restaurant and of having caused the outbreak – then the investigation would also be a criminal matter. 

A survey of restaurant patrons from the time when the cases were exposed would be more definitive and may be justified depending on the scope of the outbreak and the practical ability to find such patrons. A community phone survey might also be undertaken.

(This slide says all cases reported eating items from the restaurant, whereas an earlier slide said most cases had eaten at the restaurant.  If an astute listener asks about the difference, it is because some cases on reinterview remembered eating takeout food from the restaurant.)  
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Implement / Evaluate  
Additional Control Measures 

• Restaurant manager admonished and 
educated 

• Restaurant not closed 
• No further cases 

Presenter
Presentation Notes
NOTES:

Food service rules generally put responsibility on managers to assure that employees wash hands appropriately and keep ill employees off of work.

Some states now require that food handlers glove when preparing food. That regulation, if in force at this time, might have prevented this outbreak.  
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Write Report 

• Report written for health department 
director and food service licensing office 

• Recommends further efforts to educate 
restaurant owners to not let ill persons 
work, and to require hand-washing by 
employees.  

Presenter
Presentation Notes
NOTES:

Desired outcome is that report leads to action. 
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Hypotheses -- Theories 

• Epidemiologists develop and test theories 
about how the outbreak occurred 
– Gather information about circumstances of 

outbreak 
– Do lab tests of people, food, water, environment 
– Interview cases and non-cases to see how they 

are different 
• This is similar to how law enforcement 

investigators pursue a theory of the case with 
interviews and lab tests 

Presenter
Presentation Notes
NOTES:

This slide is intended to bring out the similarities between a criminal investigation and a public health investigation. In both disciplines the investigators form a theory of the case or outbreak, and gather information to support or rule out their theory; and this information may include interviews with key informants and witnesses as well as laboratory testing. This degree of commonality suggests that joint efforts may be very productive. 
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Where Did the Outbreak Start? 

• Most outbreaks do not have an identifiable 
scene you can put a tape around: 
– Spread is from person to person; or 
– Common source is gone; or 
– Group has dispersed from site of exposure; or 
– Source material discarded or replaced 

Presenter
Presentation Notes
NOTES:

Law enforcement and emergency response staff are usually more familiar and comfortable with incidents that can have boundaries drawn around them – an incident scene or crime scene.  Dealing with infectious disease outbreaks may require a somewhat different way of working. This is an area where tensions may arise in joint investigations. Conversely, public health workers are not used to working in crime or incident scenes where other people are in charge and can limit or direct their movements and activities. 
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What Should Make You Suspect 
an Intentional Outbreak? 

• Cases of an extremely rare disease (anthrax, plague, 
smallpox) that could be BT agent 

• Ordinary disease but out of season or area or with wrong 
mode of spread or other unusual characteristics (I.e. 
antibiotic resistance, atypical symptoms or victim 
demographics) 

• Cannot solve outbreak with usual techniques 
• Threats received 
• Group taking credit 
• Plausible accusations 

Presenter
Presentation Notes
NOTES:

Cases of disease due to one of the likely BT agents would be suspect, particularly if they cannot be explained by natural causes – e.g., plague in a person recently traveling in New Mexico versus a person living in a non-endemic area with no travel history. 
 
An outbreak due to a common agent but in the wrong season or with an unprecedented or mysterious mode of spread should raise suspicion of being intentional. An outbreak of a disease in a novel geographic area – e.g., anthrax on the East Coast – should also raise suspicion. Threats to cause an outbreak like the one observed would be highly indicative of an intentional outbreak.

Ditto if a group takes public credit for an attack or outbreak.

Accusations would need to be assessed carefully. Employees at a facility where an outbreak is centered may have information suggesting an intentional attack by someone they know, for example.
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What Should Make You Suspect 
an Intentional Outbreak? 

• All victims attended a common event 
• All victims share a common workplace or other 

locale 
• All victims work for the same agency 
• A dissemination device is found 
• Whom should PH workers call first  in this 

community when they receive allegations that 
someone has caused an outbreak deliberately? 
 

Presenter
Presentation Notes
NOTES:

Local protocols may call for local public health to call local law enforcement; or for local public health to call state public health first, and only then contact law enforcement. The point is to describe here what the local practice is or is supposed to be.  
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Categories of Intervention 

• Efforts directed at source of infectious 
agent 
– Vehicle 
– Vector 

• Efforts directed at people at risk 

Presenter
Presentation Notes
NOTES:

Interventions are, whenever possible, based on an understanding of how the current outbreak happened and is being spread.
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Interventions Directed at Source  

• Eliminate / treat source   
– Dispose of contaminated food, shock-chlorinate 

contaminated water 
• Isolate / treat infected persons  

– Prevent further exposures by minimizing susceptibles’ 
risk of exposure to infectious persons 

• Close contaminated sites / sources   
– Protect susceptibles by minimizing risk of exposure 

from infected sites / sources 

Presenter
Presentation Notes
NOTES:

If possible, use examples where such measures have been used locally that the audience will recognize.
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Interventions Directed at  
People at Risk 

• Reduce risk of exposure in susceptible people – 
e.g., by educating on how to avoid exposure 

• Directly protect at-risk people 
– Vaccinate  
– Post-exposure treatment with medicines or vaccines 

to prevent or lessen illness 

Presenter
Presentation Notes
NOTES:

If possible, use examples where such measures have been used locally – or national examples that have received wide publicity -- that the audience will recognize.
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Goal of Epidemiologic 
Investigation: Prevention 

This is the source of urgency for PH staff 
• Find and fix ongoing point source (like 

contaminated water supply) 
• Close location until fixed 
• Take food product off the market 
• Find, isolate, and treat infectious people 
• Find exposed people, give them 

prophylactic treatment or vaccine, and/or 
quarantine them 

Presenter
Presentation Notes
NOTES:

Law enforcement officials may also feel a sense of urgency if a perpetrator has not been caught and may strike again – especially if evidence is accumulating of repeated episodes.
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Presenter
Presentation Notes
NOTES:

Use this slide to field questions from the audience.
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